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Introduction

Welcome to MIKE+ 2025.

In this Release Note, you will find information about new features of MIKE+, and what you need to know in order to install and
get started with MIKE+ 2025.

MIKE+ is our new, flexible system for modelling and designing water distribution networks and collection systems for
wastewater and storm water, as well as for modelling river networks and 2D surface flooding.

MIKE+ is offered in two versions:

MIKE+
MIKE+ ArcGIS

With MIKE+ you get:

GIS-based model building and data management

Powerful hydraulic simulation engine that supports parallel processing

Integrated water quality, fire flow, real time control, flushing, multi-source tracing and hydraulic simulation (water
distribution)

Integrated water quality, control rules, LID and Soakway, rain dependent inflow and infiltration (collection system and
river network)

Long-term statistics (collection system)

Integrated 2D hydraulic and water quality, dynamic interactions with collection system and river networks, surface
flows visualisation (2D overland)

Full undo and redo capability in all editors

Thematic mapping and integrated result visualisation

Open data models - easy integration with other applications

Instant data checking and validation

With MIKE+ ArcGIS you get:

Sophisticated GIS capabilities and smooth integration with ArcGIS Pro. MIKE+ embeds ArcGIS/ArcGIS Pro software
for GIS-based model building, data management and result presentation.
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System requirements

Operating systems

Fully supported Windows operating systems * Windows 11 Pro, version 24H2 (64 bit)

Windows 11 Pro, version 23H2 (64 bit)
Windows 10 Pro, version 22H2 (64 bit)
Windows Server 2022 Standard, version 21H2

Non-supported but partially tested operating systems ** Windows Server 2019 Standard, version 1809

Supported Linux distributions (for simulations execution only) *** = Red Hat Enterprise Linux (RHEL) 8 and 9 (all 64-bit)

*%

Ubuntu 22.04 and 20.04 (all 64-bit)

Fully supported operating systems are systems that have been tested in accordance with MIKE's Quality Assurance
procedures and where warranty and software maintenance agreement conditions apply.

Non-supported but partially tested operating systems are systems, which are not officially supported by the MIKE software
products. These operating systems have only undergone very limited testing for the purpose of MIKE software, but the
software and key features are likely to work. Installation of MIKE software on a non-supported operating system is done so
at the user's own risk. The MIKE software warranty and software maintenance agreement conditions do not apply for
unsupported operating systems and DHI is under no obligation to provide assistance or troubleshooting for cases where
the software is being used on a non-supported operating system.

Supported Linux distributions are the Linux distributions used for building and testing MIKE+ for Linux 2025. Other
distributions may or may not work and are not recommended. However, MIKE+ for Linux has been successfully installed
on several other Linux distributions, including Ubuntu Kylin, Galaxy Kylin (V10), AlmaLinux and Debian (all 64-bit). MIKE+
for Linux only supports simulations execution from command lines, excluding opening the user interface.

Please note that when running a fully supported operating system as a 'guest operating system' on a virtualization platform, it
is automatically downgraded to a non-supported operating system under the conditions provided above.

Minimum hardware/software requirements

Processor compatible with x64 instruction set, 2.2 GHz or higher

Memory (RAM) 4 GB or higher *

Storage 64 GB or higher *

Display resolution 1024 x 720 (Full HD 1920 x 1080 recommended), 24-bit color (true color)
Graphics adapter 64 MB RAM (256 MB RAM or higher recommended), 32-bit true color **

Software requirements Microsoft .NET Framework 4.7.2 or higher, for MIKE+. Microsoft .NET Desktop Runtime

*

6.0.5, or a later patch release, is also required for MIKE+ ArcGIS.

The actual required amount of memory and disk space depend on the usage (application, model setup, size of data files
etc.)
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**  MIKE+ utilizing GPU for 2D overland simulations requires a Nvidia graphics card with compute capability 6.0 or higher.
Please note that some of these graphics’ cards have varying performance in single compared to double precision
calculations. The GPU functionality is based on version 12.5 of the Nvidia® CUDA® Toolkit.

Installation

To install MIKE+:
To install MIKE+, please go to the MIKE+ product folder and execute the setup.exe file either on the MIKE 2025 USB or from
the downloaded, un-zipped installation files. Press the ‘Install’ button to begin installation.

The setup program will automatically install all necessary files and folders on your computer. Additionally, an entry is created
in the Start Menu for MIKE+.

To install MIKE+ ArcGIS:
To install MIKE+, please go to the MIKE+ product folder and execute the setup.exe file either on the MIKE 2025 USB or from
the downloaded, un-zipped installation files. Press the ‘Install’ button to begin installation.

The setup program will automatically install all necessary files and folders on your computer. Additionally, an entry is created
in the Start Menu for MIKE+.

Please choose ArcGIS Pro’s "ArcGISPro.msi" to install ArcGIS Pro separately. This version of MIKE+ comes with ArcGIS Pro
3.3. You find the installation of ArcGIS Pro in the folder "Prerequisites\ArcGIS Pro 3.3". Other versions of ArcGIS Pro might
also work with MIKE+ but are not covered by warranty and software maintenance agreement conditions.

Optional installation of PostgreSQL/PostGIS:

Both MIKE+ and MIKE+ ArcGIS are installed with SQLite/SpatiaLite. If you wish to use the alternative database option,
PostgreSQL/PostGIS then please install the two products found in the "Prerequisites\PostgreSQL 16.4" and
"Prerequisites\PostGIS 3.4.2" folders. Before you install the two products, we recommend that you read the note describing
how to install PostgreSQL/PostGIS - this is available here.

License file and dongle
Please Note that when using the local or network license option, which require a license file and a dongle, then

e the DHI License Manager must be installed separately.

¢ all licensed applications included in MIKE 2025 require a 2025 version of the DHI License Manager.

e anew license file format (file extension dhilic2) has been introduced with MIKE 2022 and these license files can only
be used together with a DHI License Manager 2022 or newer.

To use MIKE software in licensed mode, please refer to the DHI License Manager Release Notes (License Manager Release
Notes).

Product invocation

Launch MIKE+ from the Windows Start menu.

Support

For general support, please refer to our Customer Care Portal.

If you experience any difficulties, or if you have questions, please contact our Customer Care team at mike@dhigroup.com.

You can also contact your local Customer Care team for support in your local language. A list can be accessed from here.
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Important note about EPANET engine

DHI EPANET engine version 2.2 has been introduced in MIKE+ 2021 Update 1. Since then, MIKE+ has supported both DHI
EPANET 2.0 and 2.2 versions to support backward compatibility.

Many improvements have been made to version 2.2 in following releases of MIKE+, which are not necessarily supported by
version 2.0, and therefore it is strongly recommended to use the latest version 2.2 whenever possible.

MIKE+ 2025 is the last release supporting both engine versions. As from MIKE+ 2025 Update 1, DHI EPANET 2.0 will no
longer be available.

New features and fixed issues

Every new release of MIKE+ consists of new modules, new features and/or corrections to problems or significant
inconsistencies discovered in previous releases. Please find below short descriptions of the most significant news.

Release 2025

New features

Module/type New feature

General A new type of result presentation for scatter plots has been added. It allows to plot points
representing individual time steps from the result, where the X-values and Y-values are
respectively obtained from any selected result items. It can be used to e.g. visualize
correlations between water levels and discharge values in a specific location, or between a
pressure and a pump flow, etc. It is accessed from the 'Scatter plot' button in the 'Results' tab
of the ribbon. See Figure 1 below.

General A new plots manager has been added, which can save, organize, edit and re-open result
windows. It saves results settings (typically the locations, result items and source result files),
but results are loaded from the result file only when opening the result window, and it
therefore allows quickly reopening pre-defined result windows to visualize updated simulation
results after re-running a simulation. It can save result windows from time series plots, profile
plots, result maps, results tables, cross section plots, scatter plots, bar charts and organize
them in folders. It also allows duplicating result windows and editing the settings for time
series plots and profile plots before opening them, to e.g. display results from an alternative
result file. This plots manager is by default shown in the left panel (‘Plots' tab) and can be
opened using the 'Plots view' button in the 'Project’ tab in the ribbon. See the 'Plots
Management' chapter from the Model Manager user guide for more information on how to use
this new feature. Also see Figure 2 below.

General The former 'Result Items’ window used to select result items to plot from 1D result files, and
accessed from the context menu of the list of result files or from buttons in the ribbon, has
been revisited to offer improved workflows. It is now replaced by distinct selection windows for
result maps, time series plots, tables, etc. When creating new time series plots or result
tables, these revisited dialogs now offer new filtering options to show only selected result
items or selected ranges of chainages. They also contain a new option to select items from
the current selection on the map.

General In the 'Results’ panel showing the list of loaded result files, it is now possible to remove
selected files all at once. This is achieved either using the 'Remove' button at the top or using
the 'Remove' option in the context menu.

General A new option in the context menu of time series plots (right-click on the plot) allows saving the
time series to .dfsO file, e.g. for future usage as input time series.
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A new option in the context menu of time series plots in the 'Plots and statistics' editor (right-
click on the plot) allows copying the computed and measured time series to clipboard, so that
they can be pasted in another program for custom analyses and processing.

A new option in the context menu of results tables (right-click on the table) allows saving the
content of the table to a text file in .csv format, for use in another program.

In the 'Versions management' tools, the Update tool used to either fully update a feature (e.g.
node or pipe) with all its changes from the new asset data or keep it fully unchanged. This tool
now offers more control, and allows managing some conflicts at the attribute level, so that it is
possible to update only some of the attributes (e.g. diameter) while keeping others
unchanged.

MIKE+ now supports longer feature names (in MUID fields). Note that for Water Distribution
models, this is only supported with the engine version DHI EPANET 2.2.

Adding a TIF image as a layer on a map now allows reading image coordinates from that file,
when available.

The 'Import and export' tool can now import and export data to/from the table m_Selection, to
handle selections saved in the Selection manager.

A new option 'Auto-refresh changes made by others' has been added to the 'User
preferences' dialog. When multiple users work simultaneously on a PostgreSQL / PostGIS
database and they all have this option active, it forces a synchronization of all MIKE+
instances.

Coupling of the collection system network in MIKE+ to MIKE SHE now also allows coupling
soakaway nodes. It allows coupling to the overland flow, overland drainage, saturated zone
and saturated zone drainage from MIKE SHE.

A new tool 'Transfer MIKE 1D data to SWMM' has been added, which transfers the main
network data defined in the model type 'Rivers, collection system and overland flows' to
SWMM data tables used in the model type 'SWMM collection system and overland flows'. It is
accessed from the 'Special tools' button in the 'CS network’ tab of the ribbon, next to the
former tool "Transfer SWMM data to MIKE 1D'. See Figure 3 below.

A new result item 'Spilling discharge above ground' can be saved to network result files. It
saves the discharge spilling on the surface and irreversibly leaving the model, for nodes with
a 'Spilling' cover type.

The two tools 'Show connected loads' and 'Show disconnected loads', formerly available in
the 'Catchments' tab of the ribbon, have been moved to the 'CS network' tab.

A new model data validation has been added during simulation execution, to identify and
report structures lower than the bottom or the river bed or pipe. This data error may in some
cases lead to significant volume errors during simulations.

This is now reported as an error when starting the simulation, for new model setups. It is
however reported as a warning for model setups created with older versions of MIKE+ and
upgraded to MIKE+ 2025, in order to keep validated setups running. This automatic
conversion of error into warning can be disabled, by removing the custom option
‘MessageldToWarning' from the 'MIKE 1D engine configuration' window: see Figure 4 below.

It is now possible to define alternative scenarios for data from the '‘Groundwater couplings'
editor for couplings to MIKE SHE or FEFLOW, which is now part of the 'Loads and
boundaries data' group of alternatives in the Scenario Manager.

The Data Assimilation module offers a new option to update the model based on the water
depth item, as an alternative to the water level item.
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A new tool to estimate the discharge from a 2D overland result file flowing through a cross
section is now available. It can optionally also include the discharge from a 1D network result
file, to return the total discharge from both 1D and 2D models. It is accessed with the
'‘Discharge through section' button in the 'Results' tab of the ribbon. In this first version of the
tool, only .dfsu result file format is supported but not .dfs2 format. See Figure 5 below.

A new tool to derive hazard values from water depth and speed from a 2D overland result file
is now available. It can also derive additional results like total duration of the flood, time to the
start of the flood or time to the peak of the flood. It is accessed with the 'Create hazard map'
button in the 'Results' tab of the ribbon. See Figure 6 below.

While loading a 2D result file into MIKE+, it is now possible to select result items to plot on the
map at the same time. See Figure 7 below.

Isolines displayed on the map for 2D result layers can now be exported to shape files. This
option is available in the context menu of the result layer in the 'Layers and symbols' tree,
along with the former export options. See Figure 8 below.

Preparation of coupled 1D-2D simulations (export step for creating a .couple simulation file)
with a large number of couplings is now significantly faster.

In Cross section plots, showing water level results across 1D and 2D domains, the tooltip now
shows also the water depth value.

In the Scenario Manager, 2D overland data have been separated into two groups of
alternative data, respectively for 2D boundary data and remaining 2D overland data. This
change eases the definition of scenarios combining various alternatives of boundary
conditions with alternatives of 2D model structure.

The calculation of the QH-relation tables for 2D Culvert structures has been updated to
improve alignment with culverts in 1D networks.

The MIKE Zero Toolbox, available in the ‘Tools’ tab from the ribbon, offers a new ‘Dfsu
Statistics’ tool to compute statistical values from time-varying data in .dfsu files.

The ‘Data Viewer’, used to open .mesh or .dfsu files from the ribbon, offers multiple
improvements:

e Ability to reproject mesh files, from the ‘Data’ menu in the upper toolbar

e Ability to save and load polygon location after drawing a selection polygon on the
map, to easily repeat manual post-processing operations

e Ability to view area of each element selected within a polygon, for improved post-
processing operations

e Ability to save and load time series point locations after picking some locations on
the map, with the ‘Position of time series’ tool.

In previous versions of MIKE+, the head loss formula was selected in the 'Simulation setup'
editor. This could possibly be a source of mistake if different simulations were defined with a
different head loss formula, because e.g. the 'Pipes' editor showed roughness values
corresponding to the formula selected for the active simulation, only. This has been changed
so that the head loss formula is now selected in the 'Model type' editor and is identical for all
simulations in the project. See Figure 9 below.

The head loss formula 'Modified Hazen-Williams' is now also supported. It is only available
when using the engine version DHI EPANET 2.2. See Figure 9 below.

Actual operating Q-H points from simulation results in pumps can now be displayed in the
'Pumps' editor and compared to the theoretical pump curve. These results are added using
the 'Pump QH plot' button in the 'Results' tab of the ribbon. While animating results, the point
from the current time step is also displayed with a specific symbol. See Figure 10 below.
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Fixed issues

Module/type

General

General

General

General

General

General

General

General

General

General

General

A new 'Operational volume' value is shown for tanks with variable level and air-chambers. It
describes the usable volume of the reservoir, i.e. the volume corresponding to the range of
level in which the reservoir operates. It is automatically computed as a function of the
specified geometrical properties of the tank or air-chamber.

A new 'Full stroke time' parameter is added to the Valves editor, for use in Water Hammer
simulations. It controls the time for the valve to move from fully open to fully closed position.

It is now possible to define alternative scenarios for data from the 'Zones' editor, which is now
part of the 'Water demands' group of alternatives in the Scenario Manager.

Enabled lateral correction output when using data assimilation module. Lateral correction
enabled for discharge observations only.

Added stack trace to log file.

Enabled coupling of MIKE 1D river models to FEFLOW.

Error/Inconvenience

Various data validations have been added in various editors, especially to report missing
critical values.

The first column in results tables was too narrow and did not always show the entire row
number.

When a result table was opened and when the corresponding simulation was re-run, the
content of the table was not always refreshed with updated results at the end of the
simulation.

After loading a saved configuration in the 'Import and export' tool, it was sometimes not
possible to change the source unit of assignments.

When exporting data to Excel from the 'Import and export' tool, data were exported in Sl units
regardless of the selected target unit.

When attempting to import data from a CAD file in the 'Import and export' tool, some CAD
files triggered an error saying that the file was invalid.

When exporting a feature layer to a shape file from the 'Layers and symbols' tree, any user-
defined column of result added to this feature table was exported with NaN values.

The 'ArcGIS Integration' tool failed to export model data at the proper location on the map,
when working with a map projection using length units of US Feet.

The 'ArcGIS Integration’ tool failed to export map layers when the computer's settings were
set to use comma as decimal separator.

After connecting to a WMS server to get background maps, MIKE+ did not always list all map
projections supported by the server.

When starting a simulation in MIKE Cloud, the upload of files from network drives has been
fixed.
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In some cases, merging pipes with the 'Network simplification’ tool resulted in incorrect
geometry of merged pipes.

With some result files, adding a result layer on the map failed with NaN values shown in the
color palette values.

The special selection 'Load points connected to selected nodes/pipes' did not select any load
point.

Values pasted from the clipboard to the 'Curves and relations' editor were considered
expressed in Sl unit, instead of expressed in the unit shown in the user interface depending
on the selected unit system.

The 'Copy' button in the 'Simulation setup' editor did not copy the list of result files included in
the simulation.

The 'Zoom' buttons in the 'Analyse network’ window from the 'Simulation setup' editor failed to
zoom to some locations.

Result items from individual elevation zones from RDI catchments were not grouped together
when presenting the list of result items from the file.

While digitizing cross sections locations on the map with the tool 'Create and update cross
sections', pressing the 'Esc' key led to an unexpected error and wrong cross sections data
created.

When attempting to compute the Q/h relation for a river boundary in the 'Boundary conditions'
editor, an incorrect message reported that no cross section was found in case there was one,
but it was not the last one for the specified river in the 'Cross sections' editor.

Simulations sometimes reported errors about invalid catchment connections when the
connections were defined along an entire river.

An unexpected error "Object reference not set to an instance of an object" which sometimes
occurred when importing a MIKE 11 model setup has been fixed.

In the 'Weirs' editor, the graphical view of the structure ignored the '‘Datum’ value.

The path to the .xns11 file storing cross sections was lost after renaming the MIKE+ project
using the 'Save as' option.

In the 'Processed data' tab of the 'Cross-sections' editor, the angle correction was in radians
although the indicated unit is degrees.

The 2D domain level (ground level) shown at the cursor position in the lower toolbar of the
main map has been corrected when using a .dfsu file as 2D domain, so that it properly shows
values within elements instead of node locations.

The 'ldentify’ and 'Open layer editor' buttons did not work with the 1D-2D couplings layer on
the map.

2D boundary conditions were not visible on the map when the symbology type was set to e.g.
diamond, star, or other types.

MIKE+ abruptly closed down when creating a new distributed source or point source from the
map.
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Using a shape file as land cover layer in the '2D surface roughness' editor sometimes
triggered an error "lllegal storage access" when running the simulation.

When selecting a .dfs file to define building zones in the '2D infrastructures' editor, the height
type was sometimes wrongly set to 'Height above ground'.

The performance for creating a roughness file from a shape file when using the option
'‘Background layer of individual polygons' in the '2D surface roughness' editor has been
improved when the shape file contains complex polygons (containing huge numbers of
vertices and/or holes).

An unexpected error occurred when trying to create a result map from a 2D result file, if the
active time step of the animation was not set to the first time step.

During the import of MIKE FLOOD model setups, river names may be corrected to ensure a
consistent use of case in all editors, but this correction was missing in the 'Nodes' and '1D-2D
couplings' editors, hence reporting invalid river names after the import.

The 'Create couplings' tool reported incorrect river names in the Reporting tab to describe
error locations.

When creating river bank or natural channel couplings with the 'Create couplings' tool with the
option 'Channels from table’, the option to import the coupling locations from a text file did not
properly save the locations, which were lost when closing the table.

The 2D domain layer was not exported to ArcGIS Pro when requested in the 'ArcGIS
Integration' tool.

Fixed an error in the calculation of orifice coefficients for 2D culvert structures.

Fixed an error in 2D overland simulations on a GPU, where section discharge calculations
could be incorrect if the discharge line contains only one face.

Initial database validation (when opening the project) was abnormally long with some SWMM
projects.

Title and description specified in the 'Description’ editor for SWMM projects were not saved.

In the ‘Junctions’ editor, the unit of the flow coefficient shown in the user interface for emitters
has been corrected. Its usage in the simulation remains unchanged.

An error "Multiple nodes with the same ID" was returned when displaying results in the
'Property and result explorer' panel, when the model contained identical IDs for junctions and
demand allocations.

When working with scenarios with different zone extents, the 'Zones' editor wrongly listed
network zones which didn't exist in the active scenario.

Flow results from Water Hammer simulations were shown in m3/s instead of m3/h when using
the unit system 'Sl units, CMH".

Time unit for the curve type 'Pump flow setpoint' in the 'Curves and relations' editor was
wrongly shown as being in seconds whereas it is in hours.

The derived result item 'Pressure gradient' always showed 0 values.

With the Autocalibration special analysis, results were not loaded in the 'Outputs' tab at the
end of the simulation.
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Simulations reported unexpected errors about invalid controls, when regulated valves were
set as inactive (i.e. ignored in the simulation).

With the Fire flow special analysis, the list of nodes considered in the analysis wrongly
included the source (selected) node as well as inactive nodes.

Fixed bug resulting in incorrect detection of an estimated error forecast parameter.

Added check to trigger error when link channel and culvert bottom elevations are lower than
the bottom elevations of connected branches.

Enabled outputting of non-double control variables

Fixed null reference exception occurring when using mixed HD and routing branches and an
adaptive time step (TT63741).

Ensured that action active sensors are associated with the correct location, in cases where an
action is used in two or more locations (TT63893).

Fixed unit conversion and display issue (TT64694).
Fixed catchment connection link ID error (TT64916).
Fixed engine indexing error for HD branches (TT65001).

Ensured that data assimilation can be limited to the river reach holding the assimilated
measurement (TT65011).

Fixed problem with running setups saved using .mhydro extension (TT65017).
Fixed units issue when using control rules and orifices (TT65020).

Fixed performance issue when loading a dfs0 file with many items (TT65053).
Enabled transfer of instance variables between methods in scripts (TT65076).
Fixed error in calculation of hydraulic radius (TT65110).

Fixed inconsistent use of MaxDepth in culvert Qh releations (TT65111).

Fixed error occurring when reading initial conditions from a state file (TT65276).

Enabled use of minimum capacity curves when using wet well set point regulated Q-dH and
Q-H pumps (TT65322).

Fixed error occurring when using simple routing branch with catchment source (TT65344).

Fixed error occurring when using US units with PID controls (TT65487).
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Figure 1 — How to create a new scatter plot from 1D results
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Figure 2 — Accessing the new Plots manager to save, edit and open result windows
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Figure 3 — Accessing the new tool "Transfer MIKE 1D data to SWMM'
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Figure 4 — The option to convert the new data validation error into a warning, which can be disabled in updated model setups
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Figure 5 — Accessing the new ‘Discharge through section’ tool and adding output sections on a map
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Figure 6 — Accessing the new ‘Create hazard map’ tool
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Figure 7 — Selecting 2D result items to plot on map while loading 2D overland results (as previously available for 1D results)
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Figure 8 — Exporting isolines from 2D overland results to shapefile
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Figure 9 — New location for selecting the head loss type. '‘Modified Hazen-Williams formula' added.
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Figure 10 — Accessing 'Pump QH plot' tool to add pump results to the plot in the 'Pumps' editor
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